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Introduction...

This guide aims to provide a series of tips and techniques to enhance the overall
performance of your Windows PC - if you are troubleshooting existing problems, some
of these tips may also be valuable to you. Although the advice offered here is aimed
primarily at creating a more reliable and efficient Windows DAW (digital audio
workstation) platform for musicians, most of this information is also applicable to

maintaining a better Windows environment for more general use.
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Getting Started...

Here is a list of some of the main tweaks/operations that you should be aware of:

« Enable DMA for Hard Drives

+  Check for IRQ Conflicts

« Prioritise Background Services/processor scheduling
« Adjust Appearance for Best Performance
« Disable Automatic Updates

« Turn Off System Restore

« Disable Remote Desktop

« Disable Write Caching

« Disable Power Management/Screensavers
« Remove Messenger

« Disable Fast User Switching

«  Turn Off System Sounds

« Don't Use Compressed Drives

« Free Disk Space/temp files/defragment

«  Optimise Startup

« Do Not Map Through Soundcard

« Disable Error Reporting/auto restart

« Fixed Swap File

« Speed Up Menus

« Disable Balloon Tips

« Disable Disc Indexing

Visit the Podcomplex Music Technology Site for more information on getting the most music from
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Setting Up A New System

This section applies to those who have built their own PC from scratch (or from a
barebones kit), have a readymade PC with no operating system installed, or who want to
completely remove their current OS and start afresh. Before doing this, of course, make
sure you have backed up all your important data to a separate physical drive or other

removable media.

If you have more than one hard drive, I recommend disconnecting all drives except the
one that Windows will be installed on. This will guard against inadvertent data loss, and

ensure the installation goes as smoothly as possible.

Before you begin, make sure you have all the ingredients you need for the installation:

- Windows XP installation disk (and product ID number)
- Older Windows version disks - 95/98/ME/2000 (if using an upgrade option)
- All driver discs for system hardware (sound card/video card/motherboard etc.)

- Download updated drivers for all system hardware from manufacturer site

Visit the Podcomplex Music Technology Site for more information on getting the most music from
your machine. This document © 2006 Dan Foley.
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Boot Sequence

For most users, there will probably be no need to change the boot sequence. However, if
required, it can be modified in your BIOS settings. To access the BIOS, you usually hit
‘Delete’ as the computer is booting up. The screen that appears when you start your PC
will tell you what key to press, but the message is normally something like ‘Hit Del to

enter setup’.

Once you are in the BIOS setup menu, find the boot sequence option menu and set your
optical drive (CD or DVD) as the first boot device, and your hard drive as the second.
This means the computer will first check for a bootable disc in the CD drive and boot
from that, or if there is no bootable disc in the drive, it will boot from the hard drive
instead. Most systems will have this sequence enabled by default (if you have a floppy

drive, the system usually checks this even before the CD drive).

If you have different operating systems installed on separate physical hard drives, you

can switch the boot sequence in the BIOS to choose which drive/OS loads on startup.

To find out more about BIOS settings, try Adrian Wong’s BIOS guide.

http://www.rojakpot.com/freebog.aspx

Visit the Podcomplex Music Technology Site for more information on getting the most music from
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Hard Drive Formatting

If you are installing a new version of Windows on your computer (clean install), make
sure you format the hard drive using a low-level format first. This will fill the drive with
zeroes, ensuring that all data on the disk is completely erased — particularly important if
you have used the hard drive before with other versions of Windows (or another OS
entirely). Even if your hard drive is brand new, it is a good idea to perform this step

anyway, to ensure that the drive is error-free.

A good way of doing this is by using the software tool provided by the manufacturer of

your hard drive — you can download this from their website for free. To check who made

your hard drive, open Device Manager:

Right-click on ‘My Computer’, select ‘Properties’, then click on the ‘Hardware’ tab.

In Device Manager, your hard drive manufacturer will show up under ‘Disk Drives’.

http://www.westerndigital.com

http:// www.maxtor.com/

http://www.samsung.com/Products/HardDiskDrive/index.htm

http://www.hitachigst.com

http://www.seagate.com/

Visit the Podcomplex Music Technology Site for more information on getting the most music from
your machine. This document © 2006 Dan Foley.


http://www.podcomplex.com/
http://www.seagate.com/
http://www.hitachigst.com/
http://www.samsung.com/Products/HardDiskDrive/index.htm
http://www.maxtor.com/
http://www.westerndigital.com/

While you do have the option of formatting a disk in either FAT32 or NTFS, there is no
reason to use FAT32 unless you want to run a dual-boot configuration with, for example,

Windows 98 and Windows XP on the same PC.

The XP setup (installer) program also gives you the option of formatting the hard drive.

Microsoft’s guide to formatting and partitioning a hard disk:
http://support.microsoft.com/?kbid=313348
Microsoft’s guide to creating a dual-boot system:
http://support.microsoft.com/?kbid=217210
Microsoft’s boot disk information page:
http://support.microsoft.com/default.aspx?scid=kb:en-us:Q310994

Hard Drive Partitioning

This is an optional step in setting up your new system, and there is some debate about
whether it is a good idea or not. In an ideal scenario, you should have a dedicated
physical hard drive for your operating system and program installations, and a separate

drive for your data.

If you only have one hard drive, however, I recommend creating a small (20-40GB)
partition on which to install Windows. This should be the first partition you create, as it

will be the fastest.

Due to the way hard disks are constructed, the read/write speed and access times are

faster at the outer edge of the platters then they are in the centre. Because of this, the

Visit the Podcomplex Music Technology Site for more information on getting the most music from 10
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actual performance of the drive varies quite a bit depending on which part of the drive is
being accessed — therefore, the Windows installation should be located as close to the

outer edge as possible (the first partition).

The remainder of the drive may then be allocated to the second partition, which will be
used for data storage. In general, I would recommend buying as large a hard drive as
possible — but the larger it is, the more important it is to partition. For a S00GB drive, for
example, I would have at least three partitions. This may help to reduce data loss in the

event of something going wrong further down the line.

Note: A common question that crops up when dealing with drive capacities
is the apparent discrepancy between the capacity claimed by the
manufacturer and the free space that actually shows up in Windows
Explorer. The reason for this is that while humans tend to count in base 10
(decimal), computers operate in base 2 (binary). So, what is referred to as a
500GB drive is actually 500 billion / 2230 - which shows up on your
system as 465.66GB. The "missing” 35GB is accounted for by this
conversion.

Some interesting observations about partitioning (and some good links) can be found here

- http://partition.radified.com/

If you want some serious partitioning solutions, the most reputable software in this field
is undoubtedly Symantec’s Partition Magic -

http://www.symantec.com/home homeoffice/products/overview.jsp?pcid=sp&pvid=pm8

0
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Installation Process

The actual installation should be relatively straightforward — simply insert your Windows
XP disc in the drive and restart the computer. The computer should then detect the CD
and proceed to boot from it, launching the XP installer program. You then follow the on-

screen prompts to complete the installation.

ACPI

There are two modes for installing Windows XP — ‘ACPI’ or ‘Standard PC’. ACPI stands
for Advanced Configuration and Power Interface, and allows Windows to take control of
various power management features that would otherwise be handled by the BIOS (or not
at all). This is obviously very useful for laptops, enabling features such as standby and

hibernation.

If you have a desktop PC, these features may not be of interest to you, and many
instances have been reported of ACPI actually interfering with the performance of certain
hardware. If you are experiencing inexplicable pops/stuttering or other anomalies with
your soundcard — and you can’t find any other explanation — it could be an ACPI issue.
This is more likely to be the case with Windows 2000 than XP, but is worth knowing

about nonetheless.

ACPI uses IRQ steering to reassign IRQs to the various PCI slots on your machine,
which usually isn’t a problem (this makes adding Plug and Play devices very easy).

However, some sound cards don’t like sharing IRQs - which can occasionally happen if

Visit the Podcomplex Music Technology Site for more information on getting the most music from 12
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you let Windows assign them — and it’s a good idea to have your sound card on its own

IRQ anyway.

If you want to disable ACPI at the install stage, you may be able to do it in the BIOS
using an option such as ‘ACPI Function’ (Windows will only install ACPI if all the

hardware in your system supports it).

The BIOS setting for ‘Plug and Play O/S’ should be set to ‘yes’ if you want Windows to

handle IRQ assignment and ‘no’ if you want to do it yourself in the BIOS.

Otherwise, once the Windows XP installer has begun, you will at some point see a
message that states ‘Press F6 if you need to install a third-party SCSI or RAID driver’.
Although it is not mentioned as an option onscreen, you should now press F5 instead.

This will bring you to a menu where you can select ‘ACPI” or ‘Standard PC’.

However, there is no compelling reason to disable ACPI nowadays, as Windows XP
generally does a very good job of assigning IRQs. You should only pursue this course of
action if you are experiencing problems with your hardware and have exhausted all other

possible solutions.

If you have some particular reason for wanting to set your IRQs manually, you will have
to set up your IRQs in the BIOS. For example, if you have a laptop with a firewire sound

card, the Windows IRQ assignment may lead to the firewire controller sharing an IRQ

Visit the Podcomplex Music Technology Site for more information on getting the most music from 13
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with another device. This can sometimes cause problems with the soundcard’s

performance.

If your XP disc does not have Service Pack 2 included, you will need to either install it
manually after XP has fully installed, or perform a ‘slipstream’ installation. For

information on creating a slipstreamed SP2 disc, visit the Elder Geek site —

http://www.theeldergeek.com/slipstreamed xpsp2 cd.htm

If you encounter problems booting from your XP disc, go to Microsoft’s boot disc page:

Remember that you must use the appropriate boot disc for your Windows version — XP

Home or Professional, with or without included Service Packs.

Note: The ultimate boot CD is a useful utility for diagnostic/recovery purposes.
Although you do not need this for Windows installation, it may come in handy
someday, so I recommend downloading a copy from http://www.ultimatebootcd.com/.

Visit the Podcomplex Music Technology Site for more information on getting the most music from 14
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Drivers

It is important to ensure that you have the very latest drivers for all the hardware in your
system. The most up-to-date drivers can be downloaded from the manufacturer’s website.
If you are not sure of your exact hardware setup, you can use PC Wizard to detect your
configuration and determine who made each component:

http://www.cpuid.com/pcwizard.php#directions

1. First of all you should install DirectX — the latest version of this comes bundled
with most new games, or can be downloaded directly from Microsoft —

http://www.cpuid.com/pcwizard.php#directions

2. Next, install any motherboard chipset drivers that you require. These are

essential to ensuring stable operation of your system.

- VIA http://www.viaarena.com/Default.aspx?PagelD=2

- Intel http://downloadfinder.intel.com/scripts-df-

external/Product Filter.aspx?ProductID=816&lang=eng

- nVidia http://www.nvidia.com/content/drivers/drivers.asp

- SiS http://www.sis.com/download/

If you are using a dedicated sound card (essential for musicians) and graphics
card (optional for musicians, although programs such as WaveLab do like a bit of

extra video power) then you may want to disable the onboard (integrated) sound

Visit the Podcomplex Music Technology Site for more information on getting the most music from 15
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or video. This can help reduce potential conflict problems later on. The easiest
way to do this is by not installing the chipset’s audio or video functionality in the

first place.

Install your graphics card drivers now. Again, you need the latest drivers for

your particular make/model.

ATTI https://support.ati.com/ics/support/default.asp?deptID=894

Matrox http://www.matrox.com/mga/support/drivers/home.cfm

nVidia http://www.nvidia.com/content/drivers/drivers.asp

Here’s a good tweak guide for getting the most out of your ATI
graphics card:
http://www.tweakguides.com/ATICAT 1.html

Now it’s time for the sound card drivers. To ensure the best audio and MIDI
performance, it is essential to download the latest updates for your particular
hardware. The driver CD that came with your sound card will almost certainly not
be the latest version. You can either install the drivers from the CD (and apply an

update patch later on), or you can install the latest version straight away by

Visit the Podcomplex Music Technology Site for more information on getting the most music from 16
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downloading the complete installer from your audio manufacturer’s website

(recommended).

- MOTU http://www.motu.com/

- M-Audio http://www.m-audio.com/index.php?do=support.drivers
- Edirol http://www.edirol.com/support/drivers.html

- E-Mu http://www.emu.com/support/welcome.asp?rd=download

- Hercules http://ts.hercules.com/eng/index.php?pg=files faq

- Turtle Beach http://www.turtlebeach.com/site/support/ftp.asp

For most audio applications, you should use the ASIO drivers developed for your
particular hardware. Once the drivers are installed, each application you use will
give you the option of choosing an audio driver — usually under ‘Settings’ or
‘Preferences’. So if you have an M-Audio Ozone, for example, choose ‘M-Audio

Ozone ASIO’ as your audio driver.

5. Ifyou have any peripheral devices, you should connect them now — most will be
Plug and Play, and will not require any drivers. If you are using a USB mouse and
it seems to be working okay, there is no need to use the installation disc that came

with it, unless there is a specific feature in the software that you require.

A good site for driver links:
http://mywebpages.comcast.net/SupportCD/DriverXP.html
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Internet Usage and Virus Protection

Before you go any further (especially if you plan on connecting your newly-installed
system to the Internet), you should install a reputable anti-virus solution such as one of

the following:

- Norton AV http://www.symantec.com/nav/nav_9xnt/

- McAfee http://us.mcafee.com/root/catalog.asp?catid=av

- PC-Cillin http://www.trendmicro.com/en/products/desktop/pc-

cillin/evaluate/overview.htm

If you are happy to stick with free virus protection:

- Trend Micro Online Scanner http://housecall.trendmicro.com/

- AVG Antivirus http://free.grisoft.com/doc/2/

- Trend Micro Sysclean http://www.trendmicro.com/download/dcs.asp

- Avast! Home Edition http://www.avast.com/eng/down home.html

Find out more about viruses and virus protection at ICSA -https
://www.icsalabs.com/icsa/icsahome.php

You should also consider using Mozilla Firefox as your Internet browser, which you can

download here: http://www.mozilla.com/firefox/
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If you are using Microsoft Internet Explorer, make sure you have the latest version

installed.

The ideal setup, of course, would be to have a system dedicated entirely to your Digital
Audio Workstation — which you never let anywhere near the Internet — and have a
different PC altogether for Web surfing. However, this is not a practical solution for most
people. A cheaper alternative to this would be to have a dual-boot system, where one OS

is dedicated to the DAW and another for Internet access and general usage.

To make sure your Windows Firewall is enabled, go to Start>Control Panel>Network
Connections and right-click on the connection you are using to access the Internet. Then
select ‘properties’, and in the ‘advanced’ tab, select ‘settings’. Here you can turn on the
Windows Firewall. If you have a third-party firewall, you do not need to use the XP

firewall.
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When you do connect to the Internet, the first place you should go is to Windows Update.

m http://windowsupdate.microsoft.com

On the update site, perform a ‘custom’ scan to detect all high priority updates required for
your system. You should also select any ‘Optional Hardware’ updates and proceed with

the update installation.

Once your update of Windows is complete, you can then proceed to install any

applications that you will be using on your system (Cubase, Reason and so on).
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Optimising Your System

There are a number of tweaks which you can perform to get better performance out of
Windows XP, depending on your requirements. For the general user, the default settings
are perfectly adequate and tweaking your system will not bring any noticeable benefits.
However, if you want to keep your PC running as smoothly as possible, this section
contains lots of important tips that you should know about, particularly if you plan on

using your machine to produce music.

PC Maintenance

There is a certain amount of maintenance everyone should do to ensure their system
doesn’t become grindingly slow over time. Particularly when using the Internet, most
systems tend to accumulate a myriad of tools, utilities and programs (which may be used
once and then forgotten about), as well as the usual complement of spyware, adware,

viruses, trojans and so on.

When using the Internet, make sure you have a Firewall and Antivirus software enabled
at all times. For more information about virus protection, see the section on ‘Internet

Usage and Virus Protection.’

Here is a list of things you should do on a regular basis:
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1. Check for Windows Updates

Go to http://windowsupdate.microsoft.com to get Windows security updates.

2. Update your Antivirus Software/run virus scan

Visit your antivirus software website to get regular virus protection updates.

3. Run a Spyware/Adware scan

There are a number of Spyware/Adware/Malware removal products available —

here are some you should try:

Ad-Aware http://www.lavasoftusa.com/software/adaware/

CCleaner http://www.ccleaner.com/downloadbuilds.asp

Spybot Search & Destroy http://www.safer-networking.org/en/mirrors/index.html

Microsoft Windows Defender

http://www.microsoft.com/athome/security/spyware/software/default.mspx

A-Squared Trojan Removal http://www.emsisoft.com/en/software/free/

Browser Hijack Prevention http://www.spychecker.com/program/hijackthis.html

There are a huge number of programs which claim to remove spyware or other
rogue items, but which are either poor imitations of decent programs or actually
contain spyware/malware themselves. For a guide to suspect programs, visit

http://www.2-spyware.com/corrupt-anti-spyware
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4. Uninstall unused programs

Over time, you will inevitably install programs that you try once or twice, but
then forget about. You should periodically ensure that nothing is installed on your
system that you don’t actually need — go to Add/Remove Programs in Control

Panel and uninstall anything superfluous.

5. Clean out startup group

This step should be performed in conjunction with step 4 above. Many programs
configure themselves to start automatically when your PC boots up, and will
therefore be consuming processing resources in the background even when you
are not using them. The icons in the toolbar at the bottom right of your screen
indicate programs that are currently running — if you don’t know what they are,

the chances are you don’t need them.

There are a number of ways to clean out your startup group — step 4 will take care
of some items straight away. However, to view the Windows startup manager, go
to Start>Run, type in ‘msconfig’ (without quotes) and hit enter. Here you can
view and uncheck any startup items you don’t need to start automatically with

Windows.
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There are other, more powerful, tools you can use to sort out your startup
programs, such as Autoruns. http://www.sysinternals.com/files/autoruns.zip

To make sure you don’t disable any essential Windows components, go to the
‘Logon’ tab, select ‘Options’ and click the ‘Hide Microsoft Entries’ box. You can
then go and uncheck any third-party programs, which means they won’t start up

automatically with Windows.

6. Defragment hard drives

As time goes by, the files on your hard drive inevitably become fragmented — that

is, different portions of the same file are stored at different locations on your hard

disk, rather than in contiguous sectors. This means that your hard disk will have to
work harder to stick the file together - moving from one end of the disk to the

other - which slows down your access times.

Therefore, you should periodically defragment your drive. You can do this using
the Windows defragmenter — right-click on your hard drive, select ‘Properties’
and go to the ‘Tools’ tab. Select the defrag tool to clean up your drive. Remember
that this may take a while (depending on the size of your drive) and you shouldn’t

use your PC for anything else whilst the defrag is underway.

Another thing worth trying is PageDefrag

http://www.sysinternals.com/Utilities/PageDefrag.html which will defragment

your pagefile (a file used by Windows as ‘virtual memory’ — sometimes referred
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to as a swap file). This pagefile needs to be defragmented separately to the rest of

your drive.

Although the built-in defrag is the best free tool for the job, you may want a more
advanced defragmentation program such as Diskeeper. http://www.diskeeper.com
You can download a 30-day trial from the website, and it is well worth a look if

you are serious about keeping your drive in optimal condition.

7. Back Up Your System and Important Files
This is something you should do as often as possible. Remember - no matter how
careful you are in maintaining your computer, your hard drive could just die at

any moment with no warning and all your data would be lost.

That is, unless you have a backup on a separate hard drive, or a separate PC, or,
ideally, in a completely different physical location altogether (remote server, data

storage unit...)!

For most people, having a remote file server dedicated to backing up their vital
files is not really a viable option. So, you should at the very least have a second

hard drive in your system for backup purposes — you can buy a large external

FireWire/USB hard drive and use that if you like.

Visit the Podcomplex Music Technology Site for more information on getting the most music from 25
your machine. This document © 2006 Dan Foley.


http://www.podcomplex.com/
http://www.diskeeper.com/

For creating an image of your system (a complete copy of every bit of data on
your hard drive, including the operating system) you will need to use some decent

imaging software. The most popular choice here is Norton Ghost.

http://www.symantec.com/home homeoffice/products/features.jsp?pcid=br&pvid

=ghost10

If you want a simple but effective (and free) backup solution, try Back2zip.

http://free-backup.info/
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XP Performance and Usability Tweaks

1. Processor Scheduling — Set to Prioritise Background Services

This is an essential tweak for musicians, but not for the general Windows user. As

most musicians will be using ASIO, it is vital to prioritise this in your system.

To do this, right-click on ‘My Computer’, then select ‘ Properties’.
In the ‘Advanced’ tab, go to Performance>Settings, click on the ‘Advanced’ tab here,
and change the processor scheduling from ‘Programs’ to ‘Background Services’

using the radio button.

2. Set Page File Size

In the same tab as the ‘Processor Scheduling’ tweak above, you will find a section

entitled ‘Virtual Memory’. Click the ‘Change’ button to modify your page file size.

The Page File is used by Windows to simulate RAM when actual physical RAM is
running low — hence the term “virtual memory’. It is also commonly referred to as a
paging file or swap file. For best performance, you should set the initial size and the

maximum size to the same value — if you have enough hard drive space, the ideal

would be 4095MB.

Visit the Podcomplex Music Technology Site for more information on getting the most music from 27
your machine. This document © 2006 Dan Foley.


http://www.podcomplex.com/
http://www.podcomplex.com/pc/optimise.html

However, I would recommend that you do not set it lower than 2GB — running out of
virtual memory is definitely a bad thing, whereas most modern PCs have multi-

gigabyte hard drives which can comfortably devote a couple of gigs to the page file.

Of course, you should have as much physical RAM in your PC as possible — it is one
of the components of your machine that has an immense impact on performance and

can be easily upgraded. At least 1GB is recommended for music applications.

If you have more than one physical hard drive, you can achieve better page file
performance by putting it on the drive that Windows isn ’f booting from — that is, you
should have your page file and your Windows installation on completely separate

physical hard drives.

To find out more about virtual memory, read Alex Nichol’s article here:

http://aumha.org/win5/a/xpvm.php

Or RojakPot’s guide here: http://www.rojakpot.com/showarticle.aspx?artno=143

3. Disable Visual Effects

Staying in the ‘Performance Options’ menu, click on the ‘Visual Effects’ tab. Here

you should select the radio button which says ‘Adjust for Best Performance’. This
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will ensure that Windows doesn’t waste any of your precious PC resources just to

make the interface look ‘prettier’.

4. Disable Error Reporting

If you close the ‘Performance Options’ menu, you will be in the ‘System
Properties/Advanced’ tab again. Here you can click on ‘Error Reporting’ and use the

radio button to disable error reporting.

This will not boost performance as such, but it will stop Windows from asking you to
send an error report any time something goes wrong with a program you’ve been
running. You can leave the ‘But notify me when critical errors occur’ checkbox

ticked.

5. Disable Automatic Restart

In the ‘System Properties/Advanced’ tab, click on the ‘Settings’ button in the ‘Startup

and Recovery’ section.

In the ‘System Failure’ section, uncheck the box marked ‘Automatically Restart’.

6. Disable Remote Access
In the “System Properties’ menu, click on the ‘Remote’ tab. Here you can uncheck the

Remote Assistance and Remote Desktop boxes.
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Unless you specifically need to access your PC from another computer, you should

disable this capability.

7. Remove Screensaver and Wallpaper

Another unnecessary visual effect is desktop wallpaper — to help keep Windows nice
and brisk, don’t use any wallpaper. Right-click on the desktop, select ‘ Properties’ and

in the ‘Desktop’ tab, select ‘None’ as your background.

While we’re here, you should also disable your screensaver. Go to the ‘Screen Saver’

tab, and select ‘None’.

Also, you should keep the number of icons (shortcuts, folders etc.) on your desktop to
a minimum — preferably none — as these also need to be loaded by Windows. Any
shortcuts you need can be stored in your quick launch menu (just to the right of the

big ‘Start’ button).

8. Disable Power Management and Hibernation

Still on the ‘Screen Saver’ tab, click on the ‘Power’ button to access the monitor

power menu. Here you can set your power scheme to ‘Home/Office Desk’.
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Now make sure that the drop-down menus for ‘Turn off monitor’, ‘Turn off hard

disks’ and ‘System Standby’ are all set to ‘Never'.

Now go to the ‘Hibernate’ tab and ensure that the ‘Enable Hibernation’ checkbox is

not ticked.

9. Turn Off Drive Indexing

By default, Windows indexes all hard drives to enable you to find files more quickly
— in practice, however, this is only beneficial for extremely complex searches and will
not benefit most users. Disabling this feature will increase your system’s overall

performance.

To do this, simply open Windows Explorer (right-click on Start and select Explore).
Then right-click on each hard drive in your system and select ‘Properties’. Here you
should uncheck the box marked ‘Allow indexing service to index this disk for fast file

searching’.

Also, never use compression on your drives, as this entails a significant performance

hit. Make sure the ‘Compress drive to save disk space’ box is left unticked.
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10. Hard Drive Write Caching

Windows XP normally uses write caching on all drives — this means that a small area
of system memory (cache) is set aside for data to be stored in before being written to

the disk itself. For most users, this results in optimal hard disk performance.

However, if you are recording (for example) a particularly long piece of audio, then
the cache may be filled before the recording is finished - at which point the contents
of the cache are suddenly dumped onto the hard drive, possibly resulting in dropouts

and glitches in the sound file.

Depending on how you use your drive, you may find that write caching either
improves or reduces performance. You can experiment for yourself to find out which

suits you best.

To enable write caching, go to the ‘Hardware’ tab in the hard drive properties menu
(see previous point), select your hard drive from the list and click ‘Properties’. Now

click on the ‘Policies’ tab and select ‘Optimise for performance’.

To disable write caching, select ‘Optimise for quick removal’. It is always a good idea
to disable write caching for removable flash drives, and also for external

USB/FireWire hard drives if you plan on plugging them in and out a lot.
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11. Reduce Recycle Bin Size

In Windows Explorer, right-click on the recycling bin and select ‘Properties’. By
default, Windows allows the recycle bin to use 10% of your drive space. This can
lead to a huge waste of space on large hard drives — 2% should be perfectly adequate

for most users.

On the ‘Global’ tab, use the slider to set the recycle bin size to a suitable value — you

will need to select ‘Use one setting for all drives’ first.

Another thing I find really useful is not having Windows ask for confirmation every
time I want to delete something. To achieve this blissful condition, simply uncheck

the ‘Display delete confirmation dialog’ box.

12. Turn Off Network Folders

Staying in Windows Explorer, click on the ‘Tools’ tab and select ‘Folder Options’.

In the ‘View’ tab, you can uncheck the box beside ‘Automatically search for network
folders and printers’. If your computer is not on a network, there is no need to have

this option enabled, and turning it off should slightly speed up your browsing.

I also recommend that you select the radio button to ‘Show hidden files and folders’.

This is not a performance tweak, but enables you to see all the files that are present on
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your machine, which can be useful when seeking out spyware or engaging in other

troubleshooting activities.

Also, it may be useful to uncheck the box which says ‘Hide extensions for known file
types’. This will allow you to view and modify file extensions (such as .wav, .avi and

SO on).

13. Disable Offline Files

If you are not on a network, or if you don’t need to access offline files, then you

should also disable this feature.

In Control Panel, select ‘Folder Options’, go to the ‘Offline Files’ tab and uncheck

the ‘Enable offline files’ box.

14. Disable or Modify System Restore

Windows XP has a built-in recovery system whereby it creates ‘restore points’ to
which you can revert if something goes wrong with a driver/program installation.
While this is a good safety net to have for most people, it does consume a lot of

system resources and experienced Windows users may want to turn it off.

To do this, click on ‘Start>Control Panel>System’ and go to the ‘System Restore’ tab.
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System Restore can also be found at ‘Start>AIll Programs>Accessories>System

Tools".

Here you can choose to disable system restore entirely, or you can simply reduce the
maximum amount of hard disk space allocated to the service. To do this, go to
‘Settings’ and adjust the slider for ‘Drive Space Usage’ to about 5% - you can set this

according to the size of your drive, but don’t go below 1GB.

15. Disable System Sounds

An important tweak for musicians, but is beneficial to all Windows users. System
sounds are the Windows bleeps that play when a specific event occurs, such as when
a warning dialog box appears. These use up resources, can ruin a perfectly good
recording by bleeping in the middle of a take, and may even reset the sample rate on

your sound card.

To disable system sounds, click on ‘Sounds and Audio Devices’ in ‘Control Panel’
and select the ‘Sounds’ tab. In the drop-down menu for sound schemes, make sure

‘No Sounds’ is selected.

In the ‘Volume’ tab, you may want to tick the box which says ‘Place volume icon in
the taskbar’. This will place a shortcut to the Windows volume control in the taskbar

for quick access to the system volume controls, which can be useful to some users.
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16. Do Not Map Through Soundcard

To prevent non-music applications from trying to play sounds through your
professional or semi-pro soundcard, you should enable this feature. If you do not use

your system for music production, you can ignore this tweak.

Go to ‘Control Panel>Sounds and Audio Devices>Hardware Tab> (select your
soundcard from the list)>Properties>Audio Devices> (select your soundcard from

the list)>Properties’, and check the ‘Do not map through this device’ checkbox.

17. Disable Automatic Updates

By default, Windows XP will periodically check on the Internet for the latest
Windows updates. However, it is not necessary to have this service constantly
running in the background — you can disable it, and still check for updates manually

when it suits you.

In Control Panel, select ‘Automatic Updates’ and select ‘Turn off automatic updates’.

18. Disable Fast User Switching

This feature basically allows one or more users to log in without a previous user
having to log out first. This means that several users can be logged into one machine
at the same time, and all programs in use by these users will be open concurrently —

which causes a significant drain on the processor.
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Unless you specifically require this facility, you should disable it.

Still in Control Panel, click on ‘User Accounts’, then select ‘Change the way users

log on or off’. Now you can disable ‘Fast user switching’ and apply changes.

19. Disable Internet Time Synchronisation

Another feature that you could do without is Windows’ obsession with always having

the correct time.

To do away with this, click on ‘Date and Time’ in Control Panel and in ‘Internet
Time’, uncheck the box which says ‘Automatically synchronize with an internet time

server’.

20. Disable Desktop Cleanup Wizard

Windows XP will try to clean up your desktop for you every couple of months — you

can disable this feature as it is fairly useless.

In Control Panel, select ‘Display’, go to the ‘Desktop’ tab and click the ‘Customise
Desktop’ button. Here you can deselect the ‘Run desktop cleanup wizard every 60

days’ checkbox.
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21. Remove Unnecessary Windows Components

Many components that are installed automatically with Windows are of little or no

use to many users and may be removed.

Before you can remove these components, you will need to edit the ‘sysoc.inf” file

which can be found in your Windows/inf folder (typically C:\Windows\inf).

If you can’t see this file, make sure the ‘Show hidden files and folders’ option is

enabled (see tweak number 11).

Open ‘sysoc.inf’ using a text editor such as Notepad.
Perform a ‘find and replace’ for the word “hide” and replace “hide” with nothing.

Save the file and exit Notepad.

In Control Panel, click on ‘Add or remove programs’ and select ‘Add or remove
windows components’. You will now be able to select all the components you wish to

get rid of — this all depends on what your requirements are.

Here are a few components you might want to uninstall:

« Accessibility options
« Indexing service
« Update root certificates

«  Windows automatic updates
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«  Windows messenger

« Games

22. Disable NTFS Access Date Logging

This tweak requires that you manually edit your registry, and as such is only

recommended for advanced Windows users.

If your hard disk is formatted using the NTFS system, then widows constantly keeps
a log of dates that files and folders are accessed on. Disabling this logging can
improve hard disk performance. However, some third-party disk defragmenters use
these logs to prioritise their defragmentation routines, so if you are running such a

program do not disable this feature. If not, you may proceed with this tweak.

The registry is a database of core program and operating system settings, and should

only be altered with the utmost caution and forethought.

To access the registry editor, click on ‘Start>Run’ and type “regedit” (without

quotes) in the text entry box.

In the editor, go to

[HKEY LOCAL MACHINE\System\CurrentControlSet\Control\FileSystem]
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and set the DWORD below as shown:

NTFSDisableLastAccessUpdate=1

If this DWORD does not exist already, you can create it by right-clicking and

selecting ‘New>DWORD value’.

23. Disable Built-in CD Burning

If you use a third-party program such as Ahead Nero (http://www.nero.com) for

burning CDs and DVDs, you can disable the built-in burning feature in Windows XP.

In the registry editor, go to

[HKEY CURRENT_ USER\Software\Microsoft\Windows\CurrentVersion\Policies\E

xplorer]

and set the DWORD below as shown:

NoCDBurning=1

24. Disable Balloon Tips

When Windows wants to tell you something, an info balloon appears in the bottom-

right of your screen. If you find these annoying, you can disable them with this tweak.
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In the registry editor, go to

[HKEY CURRENT USER\Software\Microsoft\Windows\CurrentVersion\Explorer\

Advanced]

and set the DWORD below as shown:

EnableBalloonTips=0

25. Turn Off System Beeps

Irrespective of your sound settings, or whether you have a sound card at all, Windows

sometimes uses the PC’s internal speaker to make an annoying beeping noise. You

can disable this action by editing the registry.

In the registry editor, go to

[HKEY CURRENT USER\ControlPanel\Sound]

and set the DWORD below as shown:

Beep=No
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26. Disable Windows Shortcut Key

If you find that the Windows key (between Ctrl and Alt) is getting in the way, you

can disable it by editing the registry.

In the editor, go to

[HKEY LOCAL MACHINE\System\CurrentControlSet\Control\Keyboard Layout]

and create a new Binary value called ‘Scancode Map’.

Then, double-click on this new binary value and enter the following in the value data

box. Keep the exact order shown — spaces are not necessary, and all the Os are zeroes.

00 00 00 00 00 00 00 00 03 00 00 00 00 00 5B E0 00 00 5C E0 00 00 00 00

So now you should have a new key:

Scancode Map=00 00 00 00 00 00 00 00 03 00 00 00 00 00 5B E0 00 00 5C E0 00 00

00 00

You will need to reboot for this change to take effect. To revert to your original

configuration, simply delete this entry and reboot.
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What the Windows Key does:

1. Windows: Display the Start menu

2. Windows + D: Minimize or restore all windows

3. Windows + E: Display Windows Explorer

4. Windows + F: Display Search for files

5. Windows + Ctrl + F: Display Search for computer

6. Windows + F1: Display Help and Support Centre

7. Windows + R: Display Run dialog box

8. Windows + break: Display System Properties dialog box
9. Windows + shift + M: Undo minimize all windows

10. Windows + L: Lock the workstation

11. Windows + U: Open Utility Manager

12. Windows + Q: Quick switching of users (Powertoys only)

13. Windows + Q: Hold Windows Key, then tap Q to scroll thru the different users on your pc
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27. Disable Unnecessary Hardware Detection

This is a useful tip that can radically reduce your PC’s boot up time. Basically, when your
computer is starting up, it looks around to see what hardware is present in the system. If
you tell it not to look for things you know aren’t there, you’ll save some time. This

excerpt from Sound On Sound magazine by Martin Walker explains it in more detail:

Back in April 2003 | described Microsoft's Bootvis tool for examining various aspects of XP's boot process, and at
the time stated that after various optimisations my PC took just 37 seconds to reach the desktop. | timed it again
this month and even my slimmed-down XP Music partition was taking a massive 100 seconds to boot up.
Something had obviously changed, and fortunately it didn't take me long to track down the culprit, since I'd noticed
that the boot process seemed to 'hang' at a few points, suggesting that it was searching for something that wasn't
there. After changing any of my hard, CD, or DVD drives, | always go into the BIOS and, for each drive position
(Primary Master, Slave, and so on) with nothing connected, | change the Type from its default 'Auto’ (Automatic
detection) to "Not Installed'’, so that the BIOS doesn't waste time looking for hardware that isn't plugged in.
However, I've discovered that Windows XP now ignores the BIOS settings and searches again anyway, which
meant that it was wasting time looking for four devices that didn't exist. The answer was to go into Device
Manager, expand the IDE ATA/ATAPI Controllers section, and then open in turn each entry named Primary or
Secondary IDE Channel, go to their Advanced pages and, for each instance where the Current Transfer Mode box
contained the words 'Not Applicable' (ie. nothing detected), change this Device Type from Auto Detection to None
(see screenshot). It's such a simple procedure when you know how, and my boot-up time immediately dropped

nearly 60 percent, to just 42 seconds!

See http://www.soundonsound.com/sos/marQ5/articles/pcnotes.htm for the rest of this

article.
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PC Tweaking Utilities

There are many software tools and utilities out there that claim to improve
performance under Windows XP - here are a few that are genuinely useful. These can
be used to perform some of the tweaks outlined in the “Performance and Usability
Tweaks” section. Particularly when it comes to editing the registry, it may be a better

idea to let a good utility do this for you, rather than editing entries manually.

1. TweakUl

A very useful utility designed by Microsoft, this can be used to customize the
Windows XP user interface. Once it has been installed, you can disable balloon tips,
disable autoplay, change thumbnail quality settings and much more — all in a simple

menu which can be accessed via Control Panel.

http://www.microsoft.com/windowsxp/downloads/powertoys/xppowertoys.mspx

TweakUI is one of the Microsoft PowerToys — check out the others to see if they

might be of use to you.
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2. Autoruns

This is a startup management utility — it controls what programs or processes are run
automatically when Windows loads. However, it is extremely detailed, and you

should only disable items which you are certain are unnecessary for your system.

For added safety, you should tick the ‘Hide Microsoft Entries’ box in the ‘Options’

menu.

http://www.sysinternals.com/Utilities/Autoruns.html

3. CCleaner

CCleaner is a free tool for cleaning out unnecessary files from your machine, such as
temporary files, Most Recently Used (MRU) lists, browser cache files, and log files.
The tool can analyze your PC and return a list of candidates for deletion — you can

customize the options to suit your own needs.

Again, make sure you have gone through all the settings to make sure you’re not
deleting anything that may be useful to you. Also, I recommend that you avoid
altering or deleting your Windows prefetch files (with this or any other utility) as the

default condition of this folder is usually optimal.

http://www.ccleaner.com/
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4. Ad-Aware SE

This program removes a variety of common spyware infections — just let it scan your
system and delete any items it finds. Some particularly stubborn spyware may need to
be removed in Safe Mode — just hit F8 when Windows is booting up and select ‘Safe
Mode’ from the menu. In Windows Safe Mode, run Ad-Aware again and it may

uncover a few more nasties.

http://www.lavasoftusa.com/software/adaware/

5. Spybot Search and Destroy

Spybot is another tool for spyware removal — just scan and delete. It also features a

useful ‘/mmunise’ feature which blocks spyware from installing itself in the future.

http://www.safer-networking.org/en/download/index.html
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6. PC Inspector File Recovery

This is a useful file recovery program that may be of use if you have accidentally
deleted some data that you shouldn’t have. It may also be able to recover some files
from a corrupted hard drive — however, as with all data recovery operations, nothing
is guaranteed. As soon as you discover you have lost data that needs to be recovered,
do not open any other programs, or perform any other tasks — execute your recovery

program immediately.

http://www.pc-inspector.de/file_recovery/uk/download.htm

7. RegCleaner Registry Optimiser

RegCleaner can be used to remove any old or obsolete entries from your registry.
This is a safer way of modifying your registry than using the built-in Windows editor
(which can be accessed by typing ‘regedit’ in the ‘Start>Run’ box). It also creates a

backup of your registry to which you can revert in the event of a problem.

http://www.worldstart.com/weekly-download/archives/reg-cleaner4.3.htm
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8. Bootvis Boot-Up Optimiser

Once you have your system set up as you like it, you can use this Microsoft utility to
optimize your Windows boot sequence. This program is no longer supported by
Microsoft, and requires SP2 to be installed for it to work properly on a hyper-
threading Pentium 4 machine. However, it can be used to minimize boot-up time for
Windows XP once you have all your other tweaks completed and all your programs

installed.

http://www.softpedia.com/get/Tweak/System-Tweak/BootVis.shtml
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Appendix

Things to type in the ‘Run’ box...

If you click on the Start button and then select ‘Run’, you can type in commands such as

these. Try them out and see what happens...

Osk — onscreen keyboard
Msconfig

Regedit

Services.msc
Cleanmgr.exe

Msinfo32

Devmgmt.msc

Dxdiag

Disclaimer:

All of the information in this document is provided as-is, and the author will accept no
liability for losses caused due to the use or misinterpretation of such information.
Remember to keep a regular backup of all important data, and your operating system too,
if possible. Data that exists in only one location is only an instant away from not existing
atall...!
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